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Chapter 1

Introduction

Thank you for selecting Rational Rose RealTime, the real-time 
industry's leading environment that unifies software teams by 
integrating with best-in-class Rational products including Rational 
ClearCase, Rational RequisitePro, and Rational SoDA.

These release notes describe:

� “What’s New” on page 2

� “PLEASE READ FIRST” on page 3

� “Platform Requirements — Windows NT” on page 5

� “Licensing Requirements” on page 9

� “Integration Notes” on page 11

� “Known Problems and Limitations” on page 15

� “Documentation Updates” on page 35

� “Technical Support” on page 37

Please read these Release Notes before you install or use Rational Rose 
RealTime.

Note: In some cases, you may note discrepancies between the printed 
documentation and the online documentation. In these cases, the online 
documentation is the most up-to-date and should be followed.

Please visit the Rational Web site for the latest Release Notes, patches, 
and information:

http://www.rational.com/support
Rational Rose RealTime Release Notes 1
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Chapter 1 Introduction
If you encounter any problems while installing or running Rose 
RealTime, please check here first to see if you encountered a known 
problem. If you find a problem that is not yet documented, please call 
Rational Technical Support so we can investigate it, provide you with 
a workaround, and track the problem for further action.

Contact information for this release is in “Technical Support” on 
page 37.

What’s New

These are the new features included in this release of Rational Rose 
RealTime.

� Support for Automated Testing

❑ Rational Quality Architect - RealTime

� Support for Additional platforms and languages

❑ now includes Java language support

❑ new host support

– Solaris 2.8

� Team Development Improvements

❑ Model Integrator improvements

❑ enhanced model sharing with shared interface packages

� Usability Improvements

❑ improved start-up with a customizable frameworks wizard

❑ runs in English, supports non-English data on German, 
French, Italian, Swedish, and Japanese operating systems
2 Rational Rose RealTime Release Notes
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PLEASE READ FIRST
PLEASE READ FIRST

Please read the following notes before you install Rational Rose 
RealTime.

You Must Install License Keys to Run this Product

With your software shipment, you received an envelope containing 
your Start-up License Key Certificates for this product. You need these 
keys in order to run your software. The start-up keys will expire a few 
weeks after shipment. Be sure to request your permanent license keys 
as soon as they are available. The availability date for your permanent 
keys is indicated in the top section of your Start-up Licence Key 
Certificate.

Please check the Rational Rose RealTime Installation Guide for 
detailed instructions on how to install your start-up license keys 
and how to request your permanent license keys.

Note: If you are installing license keys on a Unix platform, please refer 
to the Installation Guide for Instructions. Do not follow the instructions 
on the Rational Start-up License Certificate or on the envelope in which 
the certificate is delivered to you.

Notice To Beta Customers

IF YOU WERE A BETA CUSTOMER FOR RATIONAL ROSE REALTIME, 
PLEASE UNINSTALL BOTH THE WINDOWS AND UNIX COMPONENTS 
OF THE BETA VERSION FROM YOUR SYSTEM BEFORE BEGINNING 
YOUR INSTALLATION.

Notice To Customers Running Earlier Rose RealTime Releases

You cannot run earlier versions of Rose RealTime on Windows NT or 
Windows 2000 with the latest version of Rose RealTime.
Rational Rose RealTime Release Notes 3
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Chapter 2

Platform and Toolchain Requirements

This section describes the platform and toolchain requirements for 
running Rose RealTime.

Note: Rational Rose RealTime is not supported on Windows 95 or 
Windows 98.

Platform Requirements — Windows NT

The minimum supported configuration for running Rose RealTime on 
Windows NT is:

� Windows NT 4.0 with service pack 6a

� Minimum Pentium 150 MHz. We recommend 500 MHz or faster 
CPU

� Minimum 128 MB of RAM. We recommend 256 MB of RAM

� Minimum 325 MB of disk space for the Rose RealTime installation

� Minimum display 1024 X 768. We recommend 1280 X 1024 or 
better

� Postscript printer for printing

� Browser requirement — Internet Explorer 5.01 or 5.5 or Netscape 
Navigator 4.7 or 6.0. We recommend Internet Explorer 5.01 or 5.5

Platform Requirements — Windows 2000

The minimum supported configuration for running Rose RealTime on 
Windows 2000 is:

� Windows 2000 Professional, with service pack 1
Rational Rose RealTime Release Notes 5

 



Chapter 2 Platform and Toolchain Requirements
� Minimum Pentium 150 MHz. We recommend 500 MHz or faster 
CPU

� Minimum 128 MB of RAM. We recommend 256 MB of RAM

� Minimum 325 MB of disk space for the Rose RealTime installation

� Minimum display 1024 X 768. We recommend 1280 X 1024 or 
better

� Postscript printer for printing

� Browser requirement — Internet Explorer 5.01 or 5.5 or Netscape 
Navigator 4.7 or 6.0. We recommend Internet Explorer 5.01 or 5.5

Platform Requirements — UNIX

The minimum supported configuration for running Rose RealTime on 
UNIX is:

� Solaris 2.6, Solaris 2.7, Solaris 2.8, or HPUX 10.20

❑ For Solaris operation, the minimum workstation is an 
UltraSparc 10 with 500 MB or RAM. We recommend an 
UltraSparc 60 with 600 MB or RAM. We recommend the Solaris 
2.8 operating system.

❑ For HPUX operation, we support installation of the HP 700 
series architecture

❑ Please see the Rational Rose RealTime web site 
(http://www.rational.com/support) for a list of the required 
UNIX patches applicable to your operating system.

� The minimum is 500 MB or RAM. We recommend 600 MB of RAM

� Minimum 370 MB of disk space for the Rose RealTime installation

� Postscript printer for printing

Toolchain Requirements

Help Viewer (Windows Platforms Only)

The Help Viewer requires that Microsoft Internet Explorer (version 3.02 
or later) be set up on a user’s computer. It is not required that Internet 
Explorer be used as the system's default browser, or that the Internet 
Explorer icon be visible on the user’s desktop. 
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Toolchain Requirements
If you choose not to have Internet Explorer as the default browser, you 
will need to run Hhupd.exe. This file is the distribution executable that 
installs the run-time components needed for an HTML Help Project, 
such as Hh.exe, Hhctrl.ocx, Itss.dll, and Itircl.dll. Hhupd.exe is in the 
Redist folder of the HTML Help Workshop folder.

Compiler

You must have a C++ compiler installed on your system to make use of 
the code generation and execution capabilities for Rose RealTime. 
Different compilers are required for host workstation and for embedded 
system targets. The list of supported compilers and targets is provided 
in the Rational Rose RealTime Installation Guide.

Real-Time Operating System

If you are planning to deploy your model on a real-time operating 
system, your operating system, hardware, and tool lineup must be one 
of the supported lineups listed in the Rational Rose RealTime 
Installation Guide. If you do not have a supported lineup, you may be 
able to get support for your lineup from a Rational RoseLink partner, 
or by customizing the Rose RealTime Services Library for your target. 
See the C++ Reference or C Reference for instructions on customizing 
the Services Library and compiling for new target platforms.
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Chapter 3

Licensing Requirements

Please refer to the Installation Guide, Rational Rose RealTime for 
instructions on “Installing a Startup License” and “Obtaining a 
Permanent License”

Note: If you are installing licenses on a UNIX platform, do not follow the 
instructions on the Rational Start-up License Certificate or on the 
envelope in which the certificate is delivered to you.

If you have existing licenses for release 6.1, 6.1.1, or 6.2, you do not 
need new licenses. Please save your license file before uninstalling. 
UNIX licenses are stored in the file “license.dat”. Windows licenses are 
stored in the file “rational-server-perm.dat”. 

License Usage

A toolset launched manually will require a license. 

A second toolset session launched manually on the same platform will 
require a second license.

A toolset launched as a COM Automation server will NOT require a 
license unless it is explicitly made visible by setting the RRTEI 
Application object's Visible property to True. For more information on 
RRTEI, see the RRTEI Reference Guide in the Rose RealTime online 
Help.

A toolset launched with a compiled script passed as a command line 
argument will require a license since the toolset will be made visible 
before running the script.
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Chapter 3 Licensing Requirements
A toolset launched with both the -runScriptAndQuit and a compiled 
script passed as a command line argument, will NOT require a license 
since the toolset will not be made visible when running the script.

Note: A toolset session, regardless of how it is initiated, will require a 
license if the toolset is made visible.
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Chapter 4

Integration Notes

This section describes integrating Rational Rose RealTime with other 
tools.

Migrating from Rational Rose and ObjecTime Developer

In order to migrate models into Rose RealTime from either Rational 
Rose or ObjecTime Developer where models were previously stored in 
a configuration management system, the model must be brought into 
the Rational Rose or the ObjecTime Developer tool and written out to a 
single file. Please refer to the chapter on Migration in the Rational Rose 
RealTime Installation Guide.

When importing a model from Rose into Rose RealTime, you are 
encouraged to resolve any model errors in Rose (Tools > Check Model) 
before trying to import the model. In particular it is important to fix 
unresolved references. In general, Rose is not concerned with 
unresolved references; however, they are very important in Rose 
RealTime as they can result in incomplete code generation and 
compilation errors.

In order to export the ObjecTime model in a format that is readable by 
Rose RealTime, a patch must be applied to the 5.2 or 5.2.1 toolset to 
format the file in a single linear form file with all the required 
information. The patch is available from Rational Customer Support 
for both the 5.2 and 5.2.1 product release only. Please contact the 
Rational Customer Support group for further information.

Once the model has been imported into Rose RealTime, it can then be 
stored in the configuration management system.
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Chapter 4 Integration Notes
Microsoft Development Environment

We recommend that you install the latest service packs available from 
Microsoft for Visual Studio or Visual C++.

Configuration for Operation with Rational ClearCase

For more information on this integration, refer to the Guide to Team 
Development for Rose RealTime.

Integration with Rational Robot

Installing the 2001A.04.00 release of Rational Rose RealTime will 
interfere with the operation of the 6.1 release of Rational Robot. 

We recommend that you upgrade to the 6.3 release of Rational Robot.

Rational ClearCase on a UNIX Server and Clients on Both NT and UNIX

You can access a ClearCase server on UNIX with Rose RealTime clients 
running on both NT and UNIX workstations. For more information on 
integrating these tools, refer to the Guide to Team Development for Rose 
RealTime.

Rational SoDA

Both Rational SoDA and Rose RealTime must be properly installed and 
licensed before starting. SoDA may be installed either as part of a suite 
or as an individual product. 

Please refer to the product support page at 

http://www.rational.com/support

for the latest updates on SoDA integration.

Note: In order to generate a report using SoDA, the Rose RealTime 
model must have been saved at least once.  If the Rose RealTime model 
has never been saved, it will be untitled.  An untitled model will cause 
SoDA to generate errors.
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Rational RequisitePro

Both Rational RequisitePro and Rose RealTime must be properly 
installed and licensed before starting. RequisitePro may be installed 
either as part of a suite or as an individual product. See “RequisitePro” 
in the Rational Rose RealTime Installation Guide.

Please refer to the product support page at 

http://www.rational.com/support

for the latest updates on RequisitePro integration.

Note: The Rose RealTime Requisite Pro integration does not support the 
association of a Rose RealTime package with a RequisitePro project. Use 
Case and Model association is supported.

Rational Purify

Adding Options to Purify on UNIX

The toolset looks for an installation of Purify by checking for an 
environment variable named PURE_HOME. This environment variable 
is not set up by installing Rational Purify.

You must set this environment variable manually. The variable need 
not point to a directory containing Purify, nor is it required to point to 
a directory. The variable may contain anything, but must be set.

Occasionally, you may need to add options during a Purify'd build on 
UNIX. For example, Purify on HP needs to know the name of the linker 
or collector used by Gnu g++.

Options can be added by changing PURIFY_OPTIONS in the 
CompilationMakeInsert field of the executable component.

The default value of PURIFY_OPTIONS (generated in the Makefile by 
the code generator) is:

PURIFY_OPTIONS = -log-file=$(BUILD_TARGET).txt -windows=no

To accommodate using g++ on HP, you can add the following, or 
similar: 

PURIFY_OPTIONS = -log-file=$(BUILD_TARGET).txt -
windows=no -collector=/usr/lib/gcc-ld -g++=yes
Rational Rose RealTime Release Notes 13
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Chapter 4 Integration Notes
Where the path of to the collector, gcc-ld in most cases, should be 
the path that is specific to your environment.

For proper integration of Purify when running the Purify'd executable 
from the toolset, you should preserve the default options.

For an explanation of Purify options, see Running a component instance 
with Purify in the Toolset Guide.
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Chapter 5

Known Problems and Limitations

Installation and Startup Issues

File Association for Compiled Scripts

Windows NT: Rose RealTime does not install a file association for 
compiled scripts (.ebx). This means that they cannot be automatically 
run by double-clicking on the file from Windows Explorer.

Suite Objects.dll Not Found

When installing on Windows NT, or attempting to run Rose RealTime, 
an error message sometimes occurs indicating that “suite objects.dll” 
cannot be found in the path.

Adding “C:\Program Files\Rational\common” to the path will fix this 
problem.

This problems only occurs on Windows NT systems that have had a 
previous version of Rose RealTime installed.

Start-up Problems

If Rose RealTime has problems starting up, look at the task bar and 
use the Task Manager to see if there are running copies of Rose 
RealTime. Terminating all running copies will allow new copies of the 
tool to start properly. 

Note that more than one copy of Rose RealTime can be run at the same 
time; however, if startup problems exist, find and terminate any 
runaway processes.
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Chapter 5 Known Problems and Limitations
Uninstall

Sometimes files are left behind after an Uninstall. For example, if a 
model has been saved in one of the Rose RealTime subdirectories, the 
subdirectory and its parents will not be removed. You must remove 
these manually if you wish to return your system to a clean state.

General Issues

Unique Ids

Unique ids are unique internal names associated with model elements. 
They are used internally by Rational Rose RealTime, and not all model 
elements require unique ids. Rational Rose RealTime includes a 
feature that helps Model Integrator by generating unique ids for those 
model elements that would otherwise not require them, for internal 
use. For Model Integrator, an element with a unique id is easier to 
merge.

For information on how to enable the Unique ids, see “Model 
Specification” in the online Help.

RRTEI users will find traceability easier when they set this option. 
Unique ids improve the traceability of model elements of other tool 
integrations that use RRTEI. 

It is necessary to plan and choose when to incorporate the new unique 
ids into the project model since virtually all controlled units will be 
modified implicitly. Additionally, the generated new ids are dependent 
on time and location. For example, generating unique ids for a given 
model at different times, or on different machines, produces different 
ids.

Caution: We strongly recommend any team involved in parallel 
development use this option.

Caution: Setting this option creates unique ids for model elements that 
currently do not have them. This typically affects most of the model, so 
you will be prompted to check out those parts when setting this option. 

When saving the model, the size of the affected file increases by 
approximately 20%, and the time to load the model also increases. 
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General Issues
Caution: Do not set this option in multiple streams, otherwise, objects 
with similar characteristics will be treated differently since their unique 
id’s will differ. 

For more information about when and how to use this feature, see the 
Guide to Team Development for Rose RealTime..

Caution: If you clear this option, your merge results will not be as 
reliable.

Probes

When a message hit causes a probe to halt the execution of a running 
model, there is no way of finding out which probe in the model causes 
the model to stop executing. To determine which probe execution is 
halted on, open trace windows for each enabled probe.

License Manager

When there is no License manager running, a pop-up window appears 
indicating that the toolset cannot obtain a license.

Changes to Code that Uses Default Arguments

ObjecTime Developer models which used the RTTimespec constructor 
with only one parameter, as in the following code:

timer.informIn(RTTimespec(2));

will result in a compile error after conversion of the model to Rational 
Rose RealTime. The compile error will appear something like:

..\rtg\Driver.cpp(67) : error C2440: 'type cast' : cannot 
convert from 'const int' to 'struct RTTimespec'
No constructor could take the source type, or constructor 
overload resolution was ambiguous.

The reason is that in ObjecTime Developer, the RTTimespec 
constructor included default arguments, that is, RTTimespec (long=0, 
long=0). The default constructor values are not supported on 
RTTimespec in Rose RealTime. Any code that made use of the default 
arguments needs to be changed to supply both constructor arguments. 
For example:

OTD = RTTimespec (2);
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Chapter 5 Known Problems and Limitations
must be changed to:

RRT = RTTimespec (2, 0);

Spaces in Directory Names

On Windows NT, in order to allow the use of cross-compilers that do 
not allow spaces in the path names, you need to use the subst 
command and map a drive to the value of %ROSERT_HOME% after the 
installation. For example, if you wish to use the K: drive, and your Rose 
RealTime installation directory is: 

ROSERT_HOME=C:\Program Files\Rational\Rose RealTime

you must map this directory to the drive by running the following 
commands from a console window: 

subst K: "%ROSERT_HOME%" 
set ROSERT_HOME=K:

Spaces in directory names can cause problems with the following 
operating system.compiler library set.development platform: systems:

OSE411T.ppc603-Diab-4.3f.NT4

VRTX4T.ppc603-Microtec-1.4.NT40

TORNADO101T.i960-cygnus-2.7.2-960126.NT40

TORNADO101T.m68040-cygnus-2.7.2-960126.NT40

TORNADO101T.ppc-cygnus-2.7.2-960126.NT40

TORNADO101T.x86-cygnus-2.7.2-960126.NT40

TORNADO2T.ppc630-GreenVX-1.8.9.NT40

TORNADO2T.ppc630-GreenVX-2.0.NT40

TORNADO2T.m68040-cygnus-2.7.2-960126.NT40

TORNADO2T.ppc-cygnus-2.7.2-960126.NT40

TORNADO2T.ppc860-cygnus-2.7.2-960126.NT40

For Tornado line-ups, you should also use the substituted drive to 
point to the load script directory when running Target Observability. 
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General Issues
On the detail tab of the processor specification, the Load Script path 
should not contain any spaces. If spaces are present, when attempting 
to load the executable in Basic or Debugger-Tornado[2] modes, the 
error message, Unable to Execute appears. This does not occur when 
loading the executable in manual mode.

Spaces in directory names can also cause problems with ClearMake.

Too Many Files Open

You can have a maximum of 1024 file pointers open simultaneously.

Executing Component Instances

If you are getting the message “Unable to connect to target” when trying 
to connect to a target (both host and embedded), change the Connect 
Delay on the Component Instance specification to two or more seconds.

Sequence Diagrams

There still remain a few conditions under which the Sequence Diagram 
will incorrectly draw Messages / FOCs. If a Message or FOC appears to 
be incorrectly drawn, select the Message (or the Message that starts the 
FOC) and, using the center 'reorient' handle, slightly move the 
Message. This will force the Diagram to recalculate the correct display 
values for that message.

Build Dependencies on Case-Insensitive File Systems (NT only)

During a build, Rose RealTime detects and records build dependencies 
for comparison during subsequent builds; this is done to facilitate 
build-avoidance by only regenerating or recompiling targets when a 
build dependency has changed. These build dependencies preserve the 
case of the filenames involved, even when the underlying file-system 
(for example, NTFS) is case-insensitive. This can cause trouble when 
using names which are distinct within the toolset, and distinct on case-
sensitive drives, but indistinct on case-insensitive drives. In most 
cases, the toolset or code-generator will identify and quietly avoid or 
warn against potential case-insensitive name collisions.
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However, some case-insensitive filename collisions cannot be detected. 
For example, if a component is renamed to something that is case-
insensitive-identical (for example, renaming from “myComponent” to 
“MyComponent”), a build may incorrectly reuse all previous build 
results, since the underlying build dependencies will be indistinct 
according to the file-system.

Users are advised to use case-sensitive file-systems if possible. 
Otherwise, users should avoid case-insensitive name collisions when 
they create or rename classes, components or controllable units.

Using the Debugger-xxgdb Tool and Running your Component Instance 

When using the xxgdb tool, you should run your component instance, 
add any breakpoints and then restart it to enable the breakpoints in 
gdb. 

Running Multiple Sessions on the Same Workstation

If you are experiencing instability when running multiple Rose 
RealTime sessions on the same workstation, please try to limit your 
usage to a single session at any given time.

Use of C and C++ Add-ins

You cannot use C and C++ Add-ins at the same time in Rational Rose 
RealTime.

Symbolic Links with TargetRTS

When using LynxOS 3.1.0, do not install Visual Lynx 3.1.0 for 
Windows NT on a network (NFS) disk. It should only be installed on a 
local NTFS drive; otherwise, symbolic links to some include directories 
will not work properly. This will cause compilation errors if you re-
compile the TargetRTS.

If you have installed Visual Lynx 3.1.0 on a network disk, and if you 
see compilation errors stating that include directories netinet/in.h or 
net/if.h are not found, locate the entries net and netinet in the 
following directory:

$LYNX_HOME/usr/lynx/3.1.0/ppc/usr/include
20 Rational Rose RealTime Release Notes

 



General Issues
If these entries are text files containing the following text: 
!<symlink>bsd

rename these files and create new symbolic links called 'net' and 
'netinet' that both point to the directory bsd.

McAfee VirusScan Affects Startup and Shutdown

On Startup of shutdown, McAfee VirusScan will scan the RoseRT.ini 
file appoximately 426 times, causing a very slow startup or shutdown.

To enable a much faster shutdown, exclude the INI extension from the 
McAfee VirusScan Program File Extensions list.

Creating Capsules with the Same Name in Different Packages

While Rose RealTime allows users to create capsules with the same 
name in the different packages, Target Observability for both C++ and 
Java might confuse such capsules. 

As a temporary workaround, we recommend either renaming such 
capsules so that they have unique names, or placing the capsules to be 
observed directly under the “Logical View”. The first method is 
preferred.

Code Generator Runs Out of Memory When Generating Very Large 
Models

When you attempt to generate a very large model (over 450 classes), the 
code generator may run out of memory. 

To improve memory usage when generating very large models, we 
suggest that you:

� ensure you are using at least 1800 Mbytes of RAM.

� write each file as it is generated as opposed to generating and 
storing all the output files before starting to write any files.
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Integrations Issues

Error Loading Large Models from ClearCase 

If you have problems loading large models from ClearCase —that is, it 
takes a long time or an empty model appears—check your error 
messages. It may be because there are too many files open. Use the 
following steps to resolve this problem:

1. Go to the Control Panel, and double-click on the Clearcase applet.

The Clearcase Properties dialog appears.

2. Go to the MVFS Performance tab.

3. Under Mnodes, click the Override boxes for both “Maximun 
number of mnodes to keep on the free list” and “Maximum number 
of mnodes to keep for cleartext free list”, and set the value for both 
to “800”.

4. Click OK to apply the changes and close the dialog.

5. Reboot the Windows NT machine.

RequisitePro

When the RequisitePro add-in is enabled in Rose RealTime, there is a 
known problem with File > Save As.

There will be numerous prompts of the form

as RequisitePro attempts to save the units of RTClasses and 
RTCClasses. The number of prompts will be less if only one of C or C++ 
is enabled. Clicking OK to all the prompts causes no harm. Other 
possible workarounds are disabling the RequisitePro add-in for the 
Save As (make sure the model is saved up-to-date before doing this) or 
removing the RT packages if they aren't required at this time.

Please refer to the product support page at 

http://www.rational.com/support
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for the latest updates on RequisitePro integration.

SoDA

SoDA can be installed without Rose 2000 and will still function with 
Rose RealTime. However, when run from Rose RealTime, the menu of 
templates presented are the Rose templates, not the Rose RealTime 
ones. Some of these templates will issue errors.

Please refer to the product support page at 

http://www.rational.com/support

for the latest updates on SoDA integration.

Note that in order to install the Rose RealTime domain for SoDA, you 
need to select the Full/Customer install option during your SoDA 
installation.

Online Help Issues

Problems Accessing Rose Help when Concurrently Running Rose 
RealTime on Windows NT

Problem

Running both Rose RealTime and Rose may cause the latter not to be 
able to access its help files. 

Explanation

In order to allow Rose add-ins’ help to be accessible when used from 
within the Rose RealTime toolset, Rose RealTime temporarily replaces 
a registry key value installed by Rational Rose. This registry key is 
located in [HKEY_LOCAL_MACHINE\Software\Rational 
Software\Rose] and is named “HelpFileDir”.

When the toolset starts up, it substitutes this key’s value by its own 
Help File directory. The value installed by the Rational Rose 
installation program is backed up and restored when the last instance 
of the running toolset exits.
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Workaround

You can disable this behavior by setting the value of the key located in 
[HKEY_LOCAL_MACHINE\Software\Rational Software\Rose 
RealTime\6.3] whose name is “ReplaceRoseHelpDir” to “No”.

Java Reference

The formatting of some text (including code) does not appear correctly 
in the Java Reference online Help book. Please refer to either the 
jguide.pdf or the Java Reference book to verify the content.

Navigating through the QuickStart Tutorial Online Help

You can either select a topic in the Contents tab or click the Next or 
Previous buttons, and the topic appears in the main window.

Note: If you click Previous, although the previous topic appears in the 
main window, the incorrect topic is highlighted in the Contents tab. 
However, this does not affect the navigating to the selected topic. 

UNIX Issues

Executing the Current Version with a Previous Version

The current and previous toolsets do not work together by default, due 
to sharing the MWRPC_ENDPOINT and MWSHM_KEY environment 
variable settings. These settings are only calculated if the environment 
does not already have them set. 

To execute a current and a previous toolset from the same host or shell:

1. Invoke the first toolset with the -env parameter ( and & to have it 
run in the background)

2. Find the MWRPC_ENDPOINT environment variable and note the 
value, for example, 10633

3. Set the MWRPC_ENDPOINT environment variable for the second 
toolset to be one greater than the previous:

setenv MWRPC_ENDPOINT 10634

MWRPC_ENDPOINT values must be between 10000 and 65000 to 
be valid.

4. Set the MWSHM_KEY to the same value as the MWRPC_ENDPOINT
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setenv MWSHM_KEY 10634

MWSHM_KEY environment variable values must be integers less 
than 1048576, to be valid. We recommend that you use the RPC 
value for convenience.

5. Invoke the second toolset with the -env parameter to confirm 
environment settings.

Refresh Problems with Exceed

The screen sometimes does not refresh completely when running the 
UNIX version of Rose RealTime and displaying it on a PC using 
Hummingbird Exceed. The problem can be fixed by changing your 
Exceed settings. Start Xconfig and open the Performance dialog. Use 
the following settings: Save Unders = No, Maximum Backing Store = 
When Mapped, Default Backing Store = None, Minimum Backing Store 
= None.

HP-UX Make Dependency Filename Restriction

On the HP-UX platform, the HP-UX Make restricts dependency 
filenames to 160 characters. We recommend the use of Gnu-Make to 
work around this problem. Alternatively, you may shorten the path 
names to your class files to avoid this issue.

Non-GUI-based External Editors

On UNIX, the toolset will freeze when the user specifies “/bin/vi” as the 
external editor and then tries to launch the external editor from the 
code edit pane. If you are using a non-GUI-based external editor, this 
should be specified using “xterm -e /bin/vi” so that the editor has a 
terminal (tty) to display to. 

Case Sensitivity within Paths

The UNIX temporary directory name is translated to all lower case. If 
you set the environment variable TEMP, make sure the path name is 
all lower case or the directory will not be found. This will cause 
problems when Help is started.
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Troubleshooting Rose RealTime Toolset Freezes on UNIX

Occasionally, the Rose RealTime toolset freezes (does not respond to 
user input, window will not refresh, etc.). We have been unable to fully 
characterize these problems. If you encounter a toolset freeze, please 
complete the following steps:

1. Run “top” from your UNIX shell and save the output to a file.

2. If on Solaris, run /usr/proc/bin/pstack <Rose RealTime pid> and 
save the output to a file.

3. Kill the Rose RealTime process.

4. Run Rose RT -cleanup.

5. Attempt to reproduce the problem.

6. Note Rose RealTime build information (Help / About Rational Rose 
RealTime) and the operating system information.

7. If you are using ClearCase, were you in a ClearCase view at the 
time of the freeze and what version of ClearCase are you using?

8. Please send all the above information to Technical Support (see 
“Technical Support” on page 37 for contact information), and use 
“Rose RealTime” in the subject of your email message.

Toolset freezing on startup

Under certain configurations, when starting Rose RealTime on Solaris 
and displaying to an exceed X-server, the "Welcome to ..." window 
appears momentarily, then disappears. After this, the main application 
GUI is locked out and freezes. 

The workaround is as follows:

1. Kill the Rose RealTime process.

2. Edit the RoseRT.ini file in the ~/.registry.2001A.04.00 directory 
and change ShowStartupDialog=Yes to ShowStartupDialog=No.

3. Run RoseRT -cleanup.

4. Run RoseRT.
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Online Help

Context-sensitive help on UNIX may not invoke the correct 
help page

Context-sensitive help on UNIX may not invoke the correct help page. 
The workaround is to use the advanced search capabilities of the 
online-help to find the appropriate topic.

Cannot open some links with online help

Some links to multimedia content do not work on UNIX. 

The online help browser on UNIX does not support hyperlinks to 
external files. This affects the links to the readme file and to the 
example models. The workaround is to open the readme file with a 
regular text editor and to open the examples directly with Rose 
RealTime.

RQA-RT

Limitations

States in a specification sequence diagram are not referenced to states 
in a model (they are independent). 

RQA-RT is not supported for C models. 

Only leaf node instances in the interaction/sequence diagram can be 
specified as a driver/stub.

Within a sequence diagram, each interaction instance without a 
specified role must have a unique name. Only one interaction instance 
per test set can be left unnamed. 

Within a sequence diagram, if you run multiple tests in a single pass, 
a port from a CUT can be used by only one interaction instance with 
an unspecified role. 

As it is impossible to specify cardinality index for the interaction 
instances with no roles specified, care should be taken then using such 
objects with capsules under test and/or ports with cardinality greater 
than 1. 
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If the generated trace sequence diagram is directly compared with the 
specification diagram, it is important to remember that such 
comparison is asymmetric – sequence diagram should be used in place 
of sequence diagram; trace diagram should be used in place of trace 
diagram. 

When running multiple specifications in a test in sequence, ensure 
that you complete each sequence when using a CUT, so that the CUT 
is self-contained. This prevents a CUT from replying to a message from 
a CUT in the previous sequence diagram.

In a controlled model when you generate a new harness with affected 
model elements not checked out, many warnings will be generated.

In RQA-RT Java, there may be some problems when specifying deeply 
nested replicated subcapsules as drivers/stubs.  The RQA-RT test 
harness will not be able to distinguish particular driver instances if 
driver cardinality is greater than 1. This might lead to unexpected 
behavior as settings of the first driver instance (like minimum run time) 
will be used for all driver instances. This limitation does not applies to 
the drivers present on the top level of driver selection dialog and drivers 
with cardinality equal to 1.

Additional documentation on create messages and 
sequence diagrams

The Item Properties in the Create Message Specification dialog, with the 
exception of Thread, only apply if you are creating a Capsule Under Test 
(CUT). Thread applies in every case. The Item Properties entries are as 
follows: 

� Capsule class - A capsule name. Enter a value here only if you 
want to override the default capsule class associated with the role 
that is associated with the interaction instance being created.

� Initial data - Enter a value here only if your Capsule Under Test 
(CUT) requires data on startup. To provide data you must specify 
an attribute in the driver sending the create message with the 
appropriate initial values. You cannot provide initial data in create 
messages sent from the environment.

� Data Descriptor - If you provided initial data, you must specify the 
type descriptor of the type of data that you specified. This is in the 
format RTType_<type of initial data>.

� Thread name.
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Additional documentation on send message specification 
data field format for Java
� For the data to be passed with the messsages, the data type should 

be specified as <data_type> <constructor_arguments>. For 
example, to pass Integer object referring to the number 5, place the 
following line: Integer 5 or java.lang.Integer 5.

� If <data_type> is omitted, Integer is assumed.

� The <constructor_arguments> should contain the exact line to 
be passed as an argument to constructor. For example, for the 
MyObject(Integer, String) the following line can be used: 
MyObject 5, "Acme".

Note: No additional brackets or quotes need to be placed around 
<contructor_arguments>.

Problems Addressed

The following customer originated cases have been addressed in this 
release: 

PR number Vantive 
Case Id

Details

16004 561830 UNIX install forces you to install in a directory ending on 
/RoseRT

16880 321721 Use case name appears under use case and the name 
cannot be moved

16881 321721 Include and extends relationships in use case diagram 
should be dashed arrows

16914 325931 NT-exception: Inheritance browser

18905 372790,5 Not all incarnate functions have a default index value 
(contrary to docs)

19179 375576 Model saved with 6.0.356 cannot be loaded again - error 
invalid syntax

19303 395493 Problem with type descriptor of nested classes

19445 384230 Directions for Overriding operations within a model don't 
work
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19505 611356 Add Dependencie broken in toolset patch 0

19769 422282 Attribute descriptor not generated

19819 422518 Web Publisher not generating all the sequence diagrams

19974 441179 TypeSafeSignals (Protocol, C++ TargetRTS) doc error

20344 478235 The standard startup banner does not appear in telnet 
window when target is NT

20373 485249 Superflucious warning generated during generation

20374 485249 Codegenerator generates #includes for nested classes when 
using association

20381 491181 UNIX exception: 
0fQCOGeneralizationNUpdateBecauselP6JDepObjectP6OCO
Notification

20456 502905 UNIX exception: 
__0fQCOMonitorDiagramJhideProbeP6LCOProbeViewiTC

20459 485162 Saving .rtto and .rtusr files takes a long time when saved in 
a view

20522 474654 Main Code pain cannot launch external editor. (Expected 
functionality)

20542 v513930 Unsupported petal version 43 when opening Rose2000E 
.mdl file from RoseRT2000.02

20667 529261 Compilation error if default constructor not generated

20744 630249 RTMI: To acces Help Topics on UNIX you have to browse for 
modelintRT.hlp file

20831 551875 Show Access Violations Problem if Packages not in Logical 
View

20858 554086 C Language AddIn: Enumerate does not work as in 
documentation

20953 565206,5 Abstract capsule operation makes capsule abstract

20959 565496 Toolset does not want to import petal files with an all caps 
name

PR number Vantive 
Case Id

Details
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21096 575802 RoseRT online help: Dynamic sizing, broken link

21109 555159,5 Code copying is unpredictable

21120 579821 Odd codegeneration bug when overriding transition action 
code

21176 579208 Controlled-unit class causes NTexception if later nested in 
another class

21186 566332 Constructor argument listed filled in when overriding 
constructor

21252 591375 Forward reference not generated from Class to Protocol

21276 595769 Model conversion error (OTD 521->RRT2000)

21279 596012 Select all with ctrl+a doesn’t work

21305 598672 Def. arg. parameter (C++ Exec tab on component) does not 
work with /DEBUG (VC++)

21310 597392 Parsing error after creating link from note to external file

21323 597396 NT Exception: 001B:02E1BE40

21324 599978 UI problems on high cpu load (compilation, generation)

21325 601035 Duplicate Unique ID's in .rtto

21330 549246 The file for <elem>has changed since it was last saved or 
loaded.

21343 629178 Welcome to Rational Rose RealTime window disappears - 
locks out main GUI

21359 604459 Broken link "Diagrams Overview"

21366 595998 Tabulator width in certain edit fields

21417 607714 Long model load times with a corrupted RoseRT.ini file

21451 612867 NT Exception: 001B:0E14C074 RSCNRN22.DLL

21456 586117 Target crash when using RTS_COUNT

21532 618130 Problem with printing detail code after toolset patch 5

PR number Vantive 
Case Id

Details
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21549 615040 If trace is open model freezes -- problem sending a specific 
data class

21555 619519 Code generation failure of class scoped attributes

21562 613973 Grandchild transitions are deleted when parent class is 
deleted

21564 623041 Problem with decoding bool

21576 611109 clearmake/omake, setting OutputDirectory outside of VOB 
trips up RTmakefiles

21600 627489 Type descriptors do not take base address shift into account

21619 629511 RTWrapper assignment operator deleting wrong object.

21636 616829 Enhanced filtering support for Capsules

21653 622026 RRTEI diagram::layout() does not work correctly.

21662 638940 Anchor line from note to signal lost when importing Rose 
Models

21689 642628 UNIX Exception: 0fSCOControllableUnitNSetControlledi

21691 635725 WebPublisher state and structure diagrams don't appear on 
Windows 2000

21692 633283 Bugs in help - What's New and Readme file links don't work

21702 639009 Chinese OS - Problems with high-region ascii code "<<"

21717 636980 Runtime enters infinite loop due to RTObserver bug and 
winsock behavior

21719 639916 RoseRT hangs when CC view server is interrupted or ended

21723 648244 Model Integrator ignores Replication and Conjugated 
settings for ports

21733 643851 Testing for installation of PURIFY is flawed. PURE_HOME is 
locally set.

21749 635134 Sequence diagram from trace has criss-crossed messages

PR number Vantive 
Case Id

Details
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21753 v650965 Deleting RoseRT testscope generated framework causes 
exception

21755 639007 Purify does not report memory leaks when shut-down 
normally with TO

21778 655176 Add Class Dependencies: "Serious error occurred..." when 
elements are read-only

21787 655416 Bug in RTQueue::next causes unwired ports not to bind

21816 659684 RTPort_deregister problem

21874 668560 Can no longer open model file -- RoseRT just disappears 
without an error message

21888 669337 Duplicate text in default.mk file for C

21892 659909 Inter-thread message received in capsule before initial 
transition has executed

21895 655511 RTMI: Error: Unresolved reference from Capsule "Derived"

21896 655511 RTMI: After merge, connection added in derived capsule 
shown grey

21903 664099 Log messages from toolset load are unreachable

21939 667656 Opening large LF file in RoseRT appears to hang system

21951 674694 Rose Real Time terminates on opening class diagrams

21999 678136 RTDebugger::checkObservability() function bug

22033 682149 Public wired endport

22127 693966 Multiple Capsule Names allowed in model with no warning 
message generated

22141 681450 Unable to change the scope of a operation using the RRTEI

22150 690031 Certain cases result in sequence diagram with no messages 
when opened from trace

22194 683392 NT Exception: 001B:6C372552

PR number Vantive 
Case Id

Details
Rational Rose RealTime Release Notes 33

 



Chapter 5 Known Problems and Limitations
22206 702121 When signals are added or deleted, all elements are 
recompiled

22219 708467 RoseRT 2001 (6.2) check_rose_reqs does not check for 
required MainWin patches

22247 696033 Problems recalling messages in C TargetRTS when two 
capsules are doing recalls

22283 715564 Use of exception.userError() as documented does not work.

22299 709535 NT Exception: 001B:00573070 doubleclick on model file 
when license near expiring

22312 719109 RoseRT crashes on model load after package hierarchy 
changed

22316 718815 RQA locks up when choosing File->Exit from the debugger

22324 720671 Printing in Landscape in UNIX does not work

22352 720462 RoseRT 6.2 with GNU compiler warnings

22361 715136 RoseRT performance very slow due to repeated searching for 
Rational_Location

22366 721951 C TargetRTS -- registerAs problem if using a string var 
containing service name

22401 728429 UNIX Exception: 
1cEItemMgetRelations6kMrnKOrdCollect_pknNCRuntimeCl
ass__v_

PR number Vantive 
Case Id

Details
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Documentation Updates

For the most recent documentation updates, please visit the Product 
Support section of the Rational Rose RealTime web site at:

http://www.rational.com/support
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Chapter 7

Technical Support

This section describes how to submit problem reports, feature requests 
and support requests to Rational Technical Support.

Submitting Problem Reports

With Rational Rose RealTime, you can email problem reports to the 
Rational Software Technical Support department that services your 
location. When you email a problem report directly from the Rose 
RealTime application, a wizard guides you through the process, 
ensuring that you provide the correct information to the Rational 
Technical Support team. This information includes contact and 
location information, and a detailed description of the problem that 
you are reporting. 

To submit a problem report:

1. From the Help menu, click Email Technical Support.

A submenu appears, providing you with three options.

2. Click Problem Report.

The General Information dialog appears.

3. Type your contact and location information in the text areas 
provided and click Next.

The Problem Report - Additional Information dialog appears.

4. In the Defect Title text area, type a detailed name for the problem that 
your are reporting.

5. Select the type of problem that you are reporting from the 
appropriate list boxes.
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6. Describe the problem, using the categories provided in the Details 
area.

7. Click Next.

The Email Summary dialog appears.

8. Ensure that the information that appears in the Email Summary 
dialog is accurate. 

Note: The email information displayed in the Technical Support 
Email Address is choosen based on the location information that you 
provided in the General Information dialog. It is not recommended 
that you edit the email address. 

9. If you want to save or print a copy of the email, click the 
appropriate button.

10. Click Send Email to send your email.

Submitting Feature Requests

With Rational Rose RealTime, you can email feature requests to the 
Rational Software Technical Support department that services your 
location. When you email a feature request directly from the Rose 
RealTime application, a wizard guides your through the process, 
ensuring that you provide the correct information to the Rational 
Software Technical Support department. This information includes 
contact and location information, and a detailed description of the 
feature that your are requesting. 

To submit a feature request:

1. From the Help menu, click Email Technical Support.

A submenu appears, providing you with three options.

2. Click Feature Request.

The General Information dialog appears.

3. Type your contact and location information in the text areas 
provided and click Next.

The Feature Request - Additional Information dialog appears.

4. In the Request Title text area, type a detailed name for the Feature 
that you are requesting.

5. Select the level of urgency for the feature that you are requesting.
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6. Describe the feature, using the categories provided in the Details 
area.

7. Click Next.

The Email Summary dialog appears.

8. Ensure that the information that appears in the Email Summary 
dialog is accurate. 

Note: The email information displayed in the Technical Support 
Email Address is choosen based on the location information that you 
provided in the General Information dialog. It is not recommended 
that you edit the e-mail address. 

9. If you want to save or print a copy of the email, click the 
appropriate button.

10. Click Send Email to send your email.

Submitting Support Requests

With Rational Rose RealTime, you can email Support requests to the 
Rational Software Technical Support department that services your 
location. When you email a Support request directly from the Rose 
RealTime application, a wizard guides you through the process, 
ensuring that you provide the correct information to Rational Software 
Technical Support department. This information includes contact and 
location information, and a detailed description of the support request 
that you are submitting. 

To submit a support request:

1. From the Help menu, click Email Technical Support.

A submenu appears, providing you with three options.

2. Click Support Request.

The General Information dialog appears.

3. Type your contact and location information in the text areas 
provided and click Next.

The Support Request - Additional Information dialog appears.

4. In the Request Title text area, type a detailed name for the request 
that you require.

5. Select the level of urgency for the question with which you need 
help.
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6. Type your question in the Question text area.

7. Click Next.

The Email Summary dialog appears.

8. Ensure that the information that appears in the Email Summary 
dialog is accurate. 

Note: The email information displayed in the Technical Support 
Email Address is choosen based on the location information that you 
provided in the General Information dialog. It is not recommended 
that you edit the e-mail address. 

9. If you want to save or print a copy of the email, click the 
appropriate button.

10. Click Send Email to send your email.

Contacting Rational Technical Support by Email or Telephone

When contacting Rational Technical Support by email or by telephone, 
please be prepared to supply the following information:

� Name, telephone number, and company name

� Product name and version number

� Operating system and version number (for example, Windows NT 
4.0, Windows 2000, Solaris 2.6/2.7/2.8, or HP-UX 10.20)

� Computer make and model

� Your case id (if you are calling about a previously reported problem)

� A summary description of the problem, related errors, and how it 
was made to occur

If your organization has a designated, on-site support person, please 
try to contact that person before contacting Rational Technical 
Support.

You can obtain technical assistance by sending electronic mail to the 
appropriate email address. Electronic mail is acknowledged 
immediately and is usually answered within one working day of its 
arrival at Rational. When sending an email place “Rational Rose 
RealTime” in the subject line, and in the body of your message include 
a description of your problem.
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Contacting Rational Technical Support by Email or Telephone
When sending email concerning a previously-reported problem, please 
include in the subject field: “CaseID: v0XXXXX”, where XXXXX is the 
caseid number of the issue. For example:

CaseID: v0176528 New data on rational rose realtime install issue

Sometimes Rational technical support engineers will ask you to fax 
information to help them diagnose problems. You can also report a 
technical problem by fax if you prefer. Please mark faxes “Attention: 
Technical Support” and add your fax number to the information 
requested above.

Telephone and fax numbers for Rational Technical Support are 
contained in the following table. If you have problems or questions 
regarding licensing, please see “License Support Contact Information” 
on page 42.

Table 1  Support Telephone and Fax

Region Telephone 
Number

Fax Number

Americas  800-433-5444 408-863-4300

Asia Pacific (includes support 
for Japan, China, India, 
Korea, Taiwan)

+61-2-9419-0111 +61 2 9419 0123

Europe, Middle East, and 
Africa (includes support for 
Israel)

31 (0)20 4546 200 +31 23 569 4302

Other worldwide locations 408-863-5000
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Chapter 7 Technical Support
Email addresses for Rational Technical Support are listed in the 
following table. 

Table 2  Support Email

License Support Contact Information

If you have a problem or questions regarding the licensing of your 
Rational Software products, please contact the Licensing Support 
office nearest you.

Telephone numbers for license support are listed in the following table. 
Ask for, or select, Licensing Support.

Table 3  License Support Telephone and Fax

Region Email Address

Americas and other worldwide 
locations

support@rational.com

Asia Pacific (includes support 
for Japan, China, India, 
Korea, Taiwan)

support@apac.rational.com

Europe, Middle East, Africa 
(includes support for Israel), 
and Scandinavia

support@europe.rational.com

Region Telephone Number Fax Number

Americas  800-433-5444 781-676-2510

Europe, Israel, and Africa +31 23 554 10 62 +31 23 554 10 69

North Asia Pacific
(Mainland China, 
Hong Kong, Taiwan)

+852 2143 6382 +852 2143 6018

Korea +82 2 556 9420 +82 2 556 9426

South Asia Pacific Australia, 
New Zealand, Malaysia, 
Singapore, Indonesia, 
Thailand, The Philippines, 
Vietnam, Guam and India

+612 9419 0100 +612 9419 0160

Japan +81 3 5423 3611 +81 3 5423 3622
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Contacting Rational Technical Support by Email or Telephone
Email addresses for license support are listed in the following table.

Table 4  License Support Email

Region Email Address

Americas lic_americas@rational.com

Europe, Israel, and Africa lic_europe@rational.com

North Asia PacificMainland 
China, Hong Kong, Taiwan, 
and Korea

lic_apac@rational.com

South Asia Pacific Australia, 
New Zealand, Malaysia, 
Singapore, Indonesia, 
Thailand, The Philippines, 
Vietnam, Guam and India

lic_apac@rational.com

Japan lic_japan@rational.com
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